
274 |  C H A P T E R  6 :  M I C R O F L U I D I C S

T r a n s po r t  i n  an E l e c t r o k i n e t i c  V a l v e

This model presents an example of pressure-driven flow and electrophoresis in a 
microchannel system.

The modeled device is often used as an electrokinetic sample injector in biochips. It is 
used to get well-defined sample volumes of dissociated acids and salts and to transport 
these volumes. The model presents a study of a pinched injection cross valve during 
the focusing, injection, and separation stages. Inspiration for the model was taken from 
a study by Ermakov et. al. (Ref. 1). Focusing is obtained through pressure-driven flow 
of the sample and buffer solution, which confines the sample in the focusing channel. 
When steady state has been reached, the pressure-driven flow is turned off and an 
electric field is applied along the channels. That field drives the dissociated sample ions 
in the focusing zone at right angles to the focusing channel and through the injection 
channel. A clean separation of the sample ions is important, so this model examines 
different configurations of the electric field in this regard.

This specific case does not account for electroosmosis because the channel surfaces are 
subjected to a treatment that minimizes the extension of the electric double-layer.
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Model Definition

Figure 6-9 shows the domain’s geometry. The horizontal channel serves as the 
focusing channel while the vertical channel is the injection channel.

Figure 6-9: The focusing stage involves pressure- and electro-driven flow of the sample and 
the buffering solution from the left, top, and bottom to the right. An electric field is then 
applied over the focusing zone to impose transport down through the injection channel.

The focusing stage involves a buffering solution that is injected through pressure-
driven convection and electro-driven migration into the vertical channel. The 
buffering solution neutralizes the acids contained in the sample except for a very thin 
region confined to the junction between the horizontal and vertical channels. This 
means that the dissociated ions are found only in the needle-shaped region in the 
focusing zone.
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In the injection stage, convective flow is turned off and an electric field is applied in 
both the horizontal and vertical directions toward the upper end of the injection 
channel (see Figure 6-10).

Figure 6-10: During the injection stage, the convective flow is turned off and an electric 
field is applied. The horizontal field avoids the broadening of the sample while the vertical 
field injects the sample into the vertical channel in a direction opposite to the electric field.

The horizontal field focuses the sample during the initial part of the injection stage in 
order to obtain a well-separated sample. The vertical field is applied so as to migrate 
the sample from the focusing channel to the injection point at the lower end of the 
vertical channel. The sample ions are negatively charged and migrate in the opposite 
direction to the electric field. The simulation also covers the case where the horizontal 
field has not been applied in order to study the effect of sample distortion in the 
injection stage.

This study assumes that the concentration of charged samples is very low compared to 
that of other ions dissolved in the solution. This implies that the sample concentration 
does not influence the solution’s conductivity and that you can neglect the 
concentration gradients of the charge-carrying species, which are present in a much 
higher concentration than the sample ions. Such an electrolyte is referred to as a 
supporting electrolyte.

Further assume that concentration variations of the sample species are small in the 
direction perpendicular to the x-y plane, which reduces a 3D model to a 2D 
approximation. This assumption is not entirely true for pressure-driven flow, and a 
detailed model would treat the third dimension.
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The model uses the Navier-Stokes equations, the equation for current balance, and a 
mass balance based on the Nernst-Planck equation. The steady-state solution for the 
focusing stage serves as the initial condition for the injection stages.

The boundary conditions are changed between the focusing and injection stages, and 
the Navier-Stokes equations are not solved during the injection stage because the 
transport of the charged sample takes place through diffusion and migration 
(electrophoresis). The model equations are formulated below.

T H E  F O C U S I N G  S T A G E

The Navier-Stokes equations give the global mass a momentum balances in the 
focusing stage

t
u u u T

+– u u p+ + 0=

u 0=

 (6-5)

where  denotes the dynamic viscosity (kg/m·s), u represents the velocity vector (m/
s),  gives the fluid’s density (kg/m3), and p is the pressure (Pa).

The total balance of charges for a supporting electrolyte is given by the divergence of 
the current-density vector, which in a supporting electrolyte is given by Ohm’s law:

i –=  (6-6)

where  is the electrolyte’s conductivity (S/m), and  is the potential (V). 

You can now set up a balance of current at steady state

i 0=  (6-7)

which gives

– 0= .  (6-8)

The flux vector for the sample ions is given by the Nernst-Planck equation

Ni Di ci– ziuiFci– ciu+= ,  (6-9)

which for the focusing stage is solved in combination with a mass balance at steady-
state for species i:

Di ci– ziuiFci– ciu+ 0=  (6-10)
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where ci is the concentration (mole/m3), Di are the diffusivities (m2/s), zi is the 
charge, ui represents the mobility (mol ·m2/J·s), F equals Faraday’s constant (A·s/
mole), and  is the potential (V).

The boundary conditions for these equations follow. The model solves the Navier-
Stokes equations assuming a parabolic profile at the sample and buffer inlet 
boundaries:

u n vmean6s 1 s–=  (6-11)

where s denotes a boundary coordinate that goes from 0 to 1 along the respective inlet 
boundary. This is the Pouseuille equation for fully developed laminar flow in a channel. 
At the outlet, the velocity component tangential to the boundary is negligible and the 
pressure is constant. This gives

u t 0=  (6-12)

and

p 0=  (6-13)

where p is the relative pressure.

The boundary conditions for the balance of charge determines the potential at the 
respective inlet and outlet boundary:

0 i=  (6-14)

where i denotes the index for each boundary. All wall boundaries are assumed 
insulating so that 

n 0= .  (6-15)

The boundary conditions for the mass balance of the sample during the focusing stage 
appear next. The first equation gives the concentration at the inlet of the sample, while 
the second equation gives the concentration of the buffer at the inlet of the two vertical 
channels:

c cin=

c cbuffer=

 (6-16)

 (6-17)
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where the buffer inlets are placed at both boundaries in the vertical channel. The outlet 
boundary states that convection and migration are the dominating transport 
mechanisms at the outlet (diffusion is negligible). This gives

Ni n ziuiFci– ciu+ n= .  (6-18)

T H E  I N J E C T I O N  A N D  S E P A R A T I O N  S T A G E S

In the injection and separation stages, the flow is turned off and the configuration of 
the electric field is changed. Equation 6-8 is solved again but with new boundary 
conditions. 

The mass balance for the dilute species is given by a time-dependent mass balance

t
c + Di ci– ziuiFci– 0=  (6-19)

where the convective contribution is assumed to be zero.

The boundary conditions for the current-balance equation implies that the potential is 
locked at all boundaries except for the walls,

0 i= .  (6-20)

The walls are assumed to be electrically insulated

n 0= .  (6-21)

The boundaries for the mass balance are changed compared to the focusing stage. In 
the injection and separation stages the concentration is set at the inlet boundary 
according to

c cin= ,  (6-22)

while all other boundaries are left open, assuming that migration is the dominating 
transport at the boundaries:

Ni n ziuiFci– n=

which is an excellent assumption assuming that the sample top has not reached the 
boundary.

The time-dependent solution requires an initial condition for the mass balance. It is

c t 0= cfocus=



280 |  C H A P T E R  6 :  M I C R O F L U I D I C S

where the concentration comes from the steady-state solution obtained from the 
focusing stage.

Results and Discussion

This study covers two configurations for the potential. In the first configuration—
Mode A—the electric field in the injection stage is applied only over the injection 
channel. Figure 6-11 depicts the resulting concentration distribution in a time 
sequence.

Figure 6-11: The concentration distribution during the focusing (left) and injection 
stages (middle and right) in the electrokinetic valve’s junction where the separation step is 
part of the injection stage. The graph of the separation step shows that there is incomplete 
detachment of the sample.

The figure clearly shows that the detachment of the sample during the separation 
process is incomplete. In fact, if the separated sample is allowed to travel further down 
the injection channel, the poorly separated region remains attached to the focusing 
zone. This is also visible in Figure 6-12, which shows the cross section of the 
concentration profiles at different time steps during the simulation, 5 m from the left 
wall of the injection channel. The maximum in concentration moves downwards along 
the injection channel, but a part of the sample remains attached to the focusing zone. 
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This effect gives an unwanted distortion of the sample and a deviation from a required 
bell-curve shape for the concentration profile.

Figure 6-12: Concentration profile along the length of the injection channel at different 
time steps; 0s, 0.06s, 0.12s, 0.18s, 0.24s, 0.3s, 0.36s, 0.42s, 0.48s, 0.54s, and 0.6s after 
initiation of the injection stage. The incomplete detachment is clearly seen in the graph.

To avoid broadening of the sample top and to ensure total detachment, an electric field 
is applied in the horizontal direction, inward from both ends to the focusing zone—
Mode B. Now examine results from that simulation:

Figure 6-13: In this case the sample has almost completely detached during the separation 
stage compared to the results in Figure 6-11. It should be mentioned that the electric field 
strength has a different distribution, which gives a slightly lower migration rate.

Figure 6-13 shows the improved detachment effect that the horizontal field has on the 
separation of the sample. This is even clearer in Figure 6-14, in which the 
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concentration profile forms a nice bell curve throughout the downward transport in 
the injection channel.

Figure 6-14: Concentration profile along the length of the injection channel at different 
time steps: 0s, 0.06s, 0.12s, 0.18s, 0.24s, 0.3s, 0.36s, 0.42s, 0.48s, 0.54s, and 0.6s after 
initiation of the injection stage. The separation of the sample is substantially improved 
compared to the graphs in Figure 6-12.

This study clearly shows that modeling is extremely valuable in the investigation of 
electrophoretic transport. You can vary the configuration of the potential to obtain 
even better focusing and injection stages for the studied valve.
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Modeling in COMSOL Multiphysics

The COMSOL Multiphysics implementation is reasonably straightforward but 
deserves a few comments. The main strategy is first to solve the equations for the 
focusing stage using the nonlinear stationary solver and then for the injection stage 
using both the stationary and time-dependent solvers. The main steps are summarized 
here:

1 Solve the steady-state problem for the focusing stage, which involves the Navier-
Stokes, charge-balance, and mass-balance equations.

2 Store the solution.
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3 Change the boundary conditions for the charge balance and re-solve the equation 
for this balance only. Keep the solution for the concentration field unchanged.

4 Store the solution.

5 Change the boundary conditions for the mass balance.

6 Change the settings to a time-dependent problem and set the velocity components 
u and v to zero in the Nernst-Planck application mode.

7 Re-solve the problem.

Model Library path: 
Chemical_Engineering_Module/Microfluidics/electrokinetic_valve

Modeling Using the Graphical User Interface

1 In the Model Navigator set the Space dimension to 2D.

2 In the list of application modes select 
Chemical Engineering Module>Momentum Balance>Incompressible Navier-Stokes.

3 Click the Multiphysics button, then click Add.

4 Similarly add two more application modes:
Chemical Engineering Module>Mass Balance>Electrokinetic flow

COMSOL Multiphysics>Electromagnetics>Conductive Media DC.

5 Click OK.

O P T I O N S  A N D  S E T T I N G S

1 Select Constants from the Options menu.

2 Add the constants in the following table; when done, click OK:

NAME EXPRESSION

u_max 3e-4

v_max 1e-3

rho 1e3

eta 1e-3

D 2e-10

mob 1e-9/8.31/298

c_in 3.5/(22/35)*1e3*5e-3
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G E O M E T R Y  M O D E L I N G

1 Hold the shift key and click the Rectangle/Square button on the Draw toolbar.

2 In the Rectangle dialog box that appears, enter these properties; when done, click 
OK:

PARAMETER VALUE

Width 2e-5

Height 3.2e-4

x position 0

y position -2e-4

3 Repeat this procedure for one more rectangle with these dimensions; when done, 
click OK:

PARAMETER VALUE

Width 3.4e-4

Height 2e-5

x position -1e-4

y position 0

4 Click the Zoom Extents button on the Main toolbar.

5 Select Axes/Grid Settings from the Options menu.

6 Click the Grid tab, clear the Auto check box, and enter 2e-5 in both the x spacing

and y spacing edit fields.

7 Type -4e-6 2.4e-5 in the Extra x edit field and -4e-6 2.4e-5 in the Extra y field.

8 Click OK.

9 Click the Zoom Window button on the Main toolbar and zoom in on the junction 
area.

10 Select the 2nd Degree Bezier Curve tool on the Draw toolbar and click on the points 
(-4e-6, 2e-5), (0, 2e-5), and (0, 2.4e-5).

11 Click the Line button and click on the corner (0, 2e-5).
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12 Click the right mouse button to create a solid composite object.

13 In a similar fashion, create smoothed corners for the three other corners.

14 Press Ctrl+A to select all the geometry objects.

15 Click the Union button on the Draw toolbar and finally the Delete interior boundaries

button on the Draw toolbar.

P H Y S I C S  S E T T I N G S — F O C U S I N G  S T A G E

Boundary Conditions
1 Select 1 Incompressible Navier-Stokes (chns) from the Multiphysics menu.

2 Select Boundary Settings from the Physics menu.

3 Specify the conditions in the following table; when done, click OK:

BOUNDARY 1 2–4, 6, 8–11, 13–16 5 7 12

Boundary 
condition

Inflow/Outflow 
velocity

No-slip Inflow/Outflow 
velocity

Inflow/Outflow
velocity

Normal flow/
Pressure

u0 u_max*4*s*(1-s) 0 0

v0 0 v_max*4*s*(1-s) -v_max*4*s*(1-s)

p0 - - - - 0

4 Select 2 Electrokinetic Flow (chekf) from the Multiphysics menu

5 Set the boundary conditions as in the following table; when done, click OK:

BOUNDARY 1 2-4, 6, 8-11, 13-16 5, 7 12

Boundary 
condition

Concentration Insulation/
symmetry

Concentration Convective flux

c0 c_in 0

6 Select 3 Conductive Media DC (dc) from the Multiphysics menu

7 Set the boundary conditions as the following table; when done, click OK:

BOUNDARY 1 2-11, 13-16 12

Boundary 
condition

Electric
potential

Electric
insulation

Ground

V0 -1

Subdomain Settings
1 From the Multiphysics menu select 1 Incompressible Navier-Stokes (chns).

2 Open the Subdomain Settings dialog box from the Physics menu.
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3 Enter these subdomain conditions; when done, click OK:

SUBDOMAIN 1

rho

eta

Fx 0

Fy 0

4 Select 2 Electrokinetic Flow (chekf) from the Multiphysics menu.

5 Enter these subdomain settings; when done, click OK:

SUBDOMAIN 1

D (isotropic) D

R 0

um mob

z -1

u u

v v

V V

6 Select 3 Conductive Media DC (dc) from the Multiphysics menu.

7 Enter these subdomain settings; when done, click OK:

SUBDOMAIN 1

 (isotropic) 1

Qj 0

Je [0 0]

M E S H  G E N E R A T I O N

1 Select Free Mesh Parameters from the Mesh menu.

2 Click the Custom mesh size button and change the Mesh curvature factor to 0.6.

3 Type 1e-5 in the Maximum element size edit field.

4 Click Remesh, then click OK.

C O M P U T I N G  T H E  S O L U T I O N — F O C U S I N G  S T A G E

Start by computing the solution for the velocity field and then use that solution when 
solving the mass-transport problem.
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1 Click the Solver Manager button on the Main toolbar.

2 Click the Solve For tab and select Incompressible Navier-Stokes (chns).

3 Click the Initial Value tab and click the Initial value expression option.

4 Click OK.

5 Open the Solver Parameters dialog box from the Solve menu.

6 Select Stationary nonlinear from the Solver list. Click OK.

7 Click the Solve button on the Main toolbar.

8 When the solver has completed, open the Solver Manager dialog box to the Solve For 

page and switch to Conductive Media DC.

9 Click OK and click the Restart button on the Main toolbar.

10 Open the Solver Manager dialog box to the Solve For page and switch to Electrokinetic 

flow.

11 Click OK and click the Restart button on the Main toolbar.

The focusing stage is now complete. In the next step you solve the model for the 
transient problem that describes the injection and separation stages.

P H Y S I C S  S E T T I N G S — I N J E C T I O N  S T A G E ,  M O D E  A

Boundary Conditions
1 Change the boundary settings for the Conductive Media DC application mode as 

follows; when done, click OK:

BOUNDARY 1 5 7 12 ALL OTHERS

Boundary 
condition

Electric
insulation

Electric
potential

Electric
potential

Electric
insulation

Electric
insulation

V0 - 0 -3.2 - -

2

BOUNDARY 1 5 7 12 ALL OTHERS

Boundary 
condition

Flux Flux Flux Flux Convective 
Flux

N0 F_chekf*mob*

c*Vx

F_chekf*mob*

c*Vy

-F_chekf*mob*

c*Vy

-F_chekf*mob*

c*Vx

-

Change the boundary settings for the Electrokinetic flow mode as follows; when 

done, click OK:
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Subdomain Settings
In the Subdomain Settings dialog box for the Electrokinetic flow mode, change u and v
to 0. Click OK.

C O M P U T I N G  T H E  S O L U T I O N — I N J E C T I O N  S T A G E ,  M O D E  A

1 Click the Solver Manager button on the Main toolbar.

2 Click the Initial Value tab, click the Store Solution button, and click the Stored 

solution option in the Initial value area.

3 Click the Solve For tab and select Conductive Media (dc). Click OK.

4 Click the Solve button on the Main toolbar.

5 From the Solve menu open the Solver Manager dialog box.

6 Click the Store Solution button on the Initial Value page.

7 On the Solve For page select only Electrokinetic flow.

8 Open the Solver Parameters dialog box from the Solve menu.

9 Select Time dependent from the Solver list.

10 Type 0:0.03:0.6 in the Times edit field.

11 Click OK.

12 On the Main toolbar click the Solve button.

PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N — M O D E  A

To create Figure 6-11 on page 280, follow these steps:

1 From the Options menu open the Axes/Grid settings dialog box.

2 On the Grid page select the Auto check box.

3 On the Axis page set x min = y min = -4e-5 and x max = y max = 6e-5. Click OK.

4 From the Postprocessing menu open the Plot Parameters dialog box.

5 On the General page clear the Element refinement Auto check box and type 5 in the 
corresponding edit field.

6 Select 0 from the Solution at time list.

7 Select the Surface tab and set Surface data and choose Concentration, c from the 
Predefined quantities list.

8 Click Apply.

9 Select the General tab and select 0.06 from the Solution at time list. Click Apply.

10 Select 0.12 from the Solution at time list. Click OK.
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Figure 6-12 is created with the cross-section plot function.

1 Select Cross-Section Plot Parameters from the Postprocessing menu.

2 On the General page select every other time step from the Solutions to use list.

3 Click the Line/Extrusion tab.

4 Set y-axis data to Concentration, c (chekf).

5 Under Cross-section line data, set these parameters:

PROPERTY VALUE

x0 0.1e-4

x1 0.1e-4

y0 0.4e-4

y1 -2e-4

6 Click the Line Settings button.

7 Select Color from the Line color list.

8 Click the Color button and specify the color as black. Click OK three times.

P H Y S I C S  S E T T I N G S — I N J E C T I O N  S T A G E ,  M O D E  B

The next step is to model the second configuration of the electric field—Mode B.

Boundary Conditions
Change the boundary settings for the Conductive Media DC application mode as follows; 
when done, click OK:

BOUNDARY 1 5 7 12 ALL OTHERS

Boundary 
condition

Electric
potential

Electric
potential

Electric
potential

Electric
potential

Electric
insulation

V0 -1 0 -3.2 0 -

C O M P U T I N G  T H E  S O L U T I O N — I N J E C T I O N  S T A G E ,  M O D E  B

1 Click the Solver Manager button on the Main toolbar.

2 On the Solve For page select Conductive Media DC (dc), then click OK.

3 in the Solve>Solver Parameters dialog box select the Stationary solver.

4 Click the Solve button on the Main toolbar.

5 In the Solver Manager dialog box click the Store Solution button on the Initial Value

page.
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6 On the Solve For page select only Electrokinetic flow.

7 Open the Solver Parameters dialog box from the Solve menu.

8 Select Time dependent from the Solver list.

9 Click OK and then click Solve.

PO S T P R O C E S S I N G  A N D  V I S U A L I Z A T I O N — M O D E  B

You create the figures for Mode B in exactly the same way as the figures for Mode A.


